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This is the fourth article in a series describ-
ing the functionality expected to be included
in BSD’s forthcoming next generation
release of the SpecLink product. You can
read previous articles by visiting the BSD
website at www.bsdsoftlink.com/linkline/
current/linkLine_archives.htm. BSD is
spending hundreds
of thousands of
dollars on this next
generation initiative
to update our
technology and
support our rapidly
growing customer
base with improved
and extended
functionality.
Previous articles
discuss the rationale
behind this initiative and
BSD’s most important goals in embarking on

this development effort. They also discuss
the new user interface, new installation and
updating technologies, and E’s connected
and disconnected operation in a network
environment. The most recent article
describes BSD’s approach to achieving
meaningful interoperability between CAD,

cost, and specifica-
tions applications.

In this article we want
to talk about how use
of the system is
controlled and how
users can be man-
aged within that
system— how they
can be authenticated
and authorized when
and where it is

important to do so. Note
that until the product is

released there can and probably will be
changes to the features and functionality
described herein. This article describes the
current design intent and development
effort.

Use of the SpecLink-E (SLE) system is
affected by licensing and user role assign-
ment. One way to look at this breakdown is
that licensing provides BSD’s mechanism
for controlling use of the software and
documents, and user roles provide your
mechanism for controlling use. This article is
about role management, but let’s first talk a
little about licensing.

Licensing determines operating mode and
access rights. Access rights determine the
groups of documents or sections (catalogs)
that the user is allowed to access and
operating mode determines the type of
access. There are three operating modes
that are currently applicable: Evaluation

User Roles Dialog Box

LEEDLEEDLEEDLEEDLEED®®®®®-CS -CS -CS -CS -CS AddedAddedAddedAddedAdded
to SpecLinkto SpecLinkto SpecLinkto SpecLinkto SpecLink

The LEED Green Building Rating System™
For Core & Shell Development (LEED-CS),
Version 2.0, July 2006, has been added as an
option in the SpecLink LEED checklist
sections for the Spring 2007 Update.  Prior
to this, LEED-NC was the only certification
option offered in SpecLink's automated
checklist sections and companion forms.  To
address LEED-CS, the specifier simply
selects LEED-CS instead of LEED-NC — the
software automatically excludes LEED-NC
credits that are not applicable, adds the new
LEED-CS credits, and changes the credit
numbers where necessary.  Where credit
numbers are different between the two
rating systems, SpecLink changes the credit
numbers in each LEED-related section and
form where the numbers are referenced.

As one might expect, LEED-CS is very
similar to LEED-NC.  Since the core and shell
of a building is a subset of the whole
building, LEED-CS omits requirements that
are not under the control of the core and
shell developer.  This means some credits
are deleted, some added, and some changed,
but most of the prerequisites and credits are
the same as in LEED-NC.  SpecLink's two
sections that are automatically coordinated
to each other and to other sections of the
specification make it easy to get the credits
straight and prepare specs that address
those that can be addressed via the specifi-
cations.  The LEED Credit Summary "walks"
you through identification of the credits to
be achieved — the LEED Certification
Procedures section explains it to the
Contractor.

01 3514 -- LEED CREDIT SUMMARY -- By
editing this section you activate relevant
LEED provisions in appropriate spec
sections by documenting your decisions as

See “SpecLink-E” on page 5 See “LEED-CS” on page 4
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In Boston, New York City, and Saratoga Springs (NY), Saratoga Associates
provides Planning, Landscape Architecture, Civil Engineering, and Architectural
services to clients.
Whether
creating
compelling
destina-
tions,
enriching
communi-
ties, or
safeguard-
ing special
places
treasured
for their
historic,
cultural, or
natural
importance,
the commitment
of the people at Saratoga Associates to
their clients’ success remains the same.
They help them shape, visualize, and
realize what is needed in a way that
uses their resources wisely and
efficiently.

The Need: In 2004, they were using a
word processing based spec writing
software package. Their specifications
took too long to develop; the outcome
was anything but efficient. They knew
there was a better way to do things:
SpecLink®.

The Solution: “We now have an easier,
faster way to produce and print
specifications,” says Nina Oldenquist,
Specification Writer with Saratoga
Associates. “The ease of reporting
makes construction administration
easier — and that alone has made a
huge difference in how long it takes us
to produce specifications.”

The efficiencies gained by switching to
SpecLink manifest in many ways.
Oldenquist recalls one of the main
features that helped her decide to
switch to SpecLink. “I like the fact that
the entire project manual is a single

document, instead of 50 or 60 different
word files. In addition, we can print
reports that list sections where a
specific topic is discussed.”

The Outcome: Saratoga Associates
works on many environmentally
responsible designs. Oldenquist says,
“One of our best projects to date was a
recently completed LEED-certified
cultural center. Being able to take
advantage of the LEED front-end
sections available in SpecLink is what
made this such a great project to work
on.”

Oldenquist continues with the list of
SpecLink features she likes, “We can
add our own links — that greatly
increases automation. And the ability to
change the project name, headers,
footers, and the page format just once
for the entire document is great —
especially for those in our office who
are not accustomed to doing a lot of
word processing. Because SpecLink is
a specification writing program and not
a general purpose word processing
program, they can be more efficient
using the software.”

The The The The The Other Other Other Other Other ContractContractContractContractContract
Document FormsDocument FormsDocument FormsDocument FormsDocument Forms

An Introduction to
AGC DocuBuilder®

Many of BSD’s customers are architects who are
very familiar with AIA contract documents and
AIA’s electronic document software. Our profes-
sional engineer customers are undoubtedly familiar
with the standard contract forms published by the
Engineers Joint Contract Documents Committee
(EJCDC). However, we suspect that many of our
customers are not aware of the fact that AGC (The
Associated General Contractors of America) also
publishes a wide selection of standard contract
forms for construction. Not only are these forms
very similar in scope to those produced by AIA and
EJCDC, they are also available in a software
product that was developed by BSD for AGC—a
product named AGC DocuBuilder®.

The forms developed by AGC are well balanced and
fair, and they are created with input from a wide
range of sources. For example, The Building
Owners and Managers Association (BOMA) has
endorsed the AGC 200 general conditions docu-
ment and its AGC 400 design-build agreement. The
Associated Specialty Contractors (ASC) organiza-
tion has endorsed the AGC 650 subcontract
agreement. EJCDC has approved the AGC 510 and
520 construction management documents. Even
AIA has jointly drafted with AGC its 565 and 566
construction management-at-risk documents. AGC
has approximately 100 standard contract forms, all
of which are available in AGC DocuBuilder,
including an Owner-A/E agreement comparable in
scope to AIA’s B141 document and EJCDC’s E-500
document.

In addition to the balanced fairness of the AGC
documents, the fact that they are available in
intuitive software that looks and feels much like
BSD SpecLink® should make the product of special
interest to our customers. Anyone who has worked
with the AIA software should be especially
appreciative of DocuBuilder’s ease of use. In
addition, DocuBuilder has unique features such as
context-sensitive notes that provide background
information and explanations of particular contract
provisions.

The software allows global replacement of key
terms, such as “Contractor” and “Owner,” and it
allows users to insert project-specific headers with

The Spa at Mohonk Mountain House, New Paltz, New York.

See “AGC” on page 3
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PerSpective Performance SpecsPerSpective Performance SpecsPerSpective Performance SpecsPerSpective Performance SpecsPerSpective Performance Specs
StStStStStaaaaatistics:tistics:tistics:tistics:tistics:

• 161 sections, 9 updated (6%)
• 17,381 paragraphs
• 21,929 internal links (targets and

consequences)
• 4,015 notes to specifier, 923 with live

hyperlinks
• 189 external documents referenced, with

live hyperlinks to order information
• 50 ASTMs referenced, 100% verified

within last 9 months
• 138 other documents referenced, 79%

verified this quarter*

• 39 standards organizations referenced

SpecLink+ StSpecLink+ StSpecLink+ StSpecLink+ StSpecLink+ Staaaaatistics:tistics:tistics:tistics:tistics:
• 528 sections total, 109 updated or new

(21%)
• 1 new non-proprietary section
• 1 new proprietary section
• 524 non-proprietary sections
• 4 proprietary sections
• 49 sections with built-in checklists
• 90,708 paragraphs
• 98,376 internal links (targets and

consequences)
• 25,612 notes to specifier
• 14,847 notes with live hyperlinks to

Internet web pages
• 2,119 external documents referenced,

with live hyperlinks to order information
• 958 ASTMs referenced, 100% verified

within last 9 months

About Your SpecLink & PerSpective Updates

Short FShort FShort FShort FShort Form Specs Storm Specs Storm Specs Storm Specs Storm Specs Staaaaatistics:tistics:tistics:tistics:tistics:
• 16 sections corresponding to

MasterFormat 1995 divisions
• 5 sections updated (31%)
• 8,307 paragraphs
• 1,563 notes to specifier, 1,022 with live

hyperlinks
• 9,067 internal links (targets and

consequences)
• 363 external documents referenced
• 224 ASTMs referenced, 100% verified

within last 9 months

• 141 other documents referenced, 74%
verified this quarter*

• 43 standards organizations referenced

• 1,163 other documents referenced, 79%
verified this quarter*

• 183 standards organizations referenced
• 2,414 manufacturer listings, with live

hyperlinks to their web sites
• 941 unique manufacturers listed in 371

non-proprietary sections

* Documents issued more than two years ago are verified quarterly, as are annual or semiannual publications.  The documents not verified this quarter
were updated within the past two years.

NoNoNoNoNow Plaw Plaw Plaw Plaw Playing:ying:ying:ying:ying:
SpecLink SpecLink SpecLink SpecLink SpecLink WWWWWebinebinebinebinebinarsarsarsarsars
Building Systems Design is pleased to
announce that we are providing twice-
weekly guided tours of the BSD SpecLink®

application.  These one-hour Webinars
cover the basics of getting started develop-
ing your first project.

Subjects covered in the SpecLink Webinar
include:

• Starting a new project
• Navigation of the Menu Bar and Tree

Panel
• Discussion of the Status Columns in

the Document Panel
• Explanation of choices, options, and fill-

in-the blanks
• Creating and modifying headers and

footers
• Printing options
We offer free SpecLink Webinars twice a
week - Tuesdays at 11 AM and Thursdays
at 4 PM, Eastern Time.  Please call 1-800-266-
7732 to schedule the most convenient time
for you, and we will send you the informa-
tion needed to register.

“AGC” continued from page 2
automated keyword replacement for all
documents in a project. Users may choose
to print comparative documents that show
the changes from the standard forms by
underlining and strikethroughs, or they
can print “clean” documents that show no
changes. In the latter case, an automatic
footer is changed to alert readers to the
fact that unmarked changes may have
been made to the standard contract
language.

AGC DocuBuilder also offers more
flexibility in pricing than the AIA product.
In addition to annual subscriptions for
unlimited use and a meter mode option
that allows infrequent users to pay by the
document, DocuBuilder also offers access
to subsets of the documents. There are
four groups of documents that can be
subscribed to separately, plus a fifth
group of short form documents. For
instance, an architect might need access
only to the 200 series documents that
cover general construction. A subcontrac-
tor, on the other hand, might need only
the subcontract documents in the 600
series. Each document series is available

for a fraction of the cost of a full subscrip-
tion, and each is priced well below the
subscription price of the AIA product. It’s
even possible to buy a subscription to
one series of frequently used documents
and to combine the subscription with a
meter mode account that allows access to
infrequently used documents outside of
the subscription.

For more complete descriptions of the
documents available in each series and
the product pricing, interested parties
should visit AGC’s website, at
www.agc.org, where DocuBuilder can also
be purchased via the AGC e-store. For the
month of March 2007, new customers who
buy a DocuBuilder subscription for the
full range of documents will receive a free
iPod nano.
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SPEC WRITER JOB OPENING:  BSD is
looking for an architect or engineer to join
us in maintaining and expanding
SpecLink.  For more information, go to
www.bsdsoftlink.com/bsdjobs.htm or call
(888) BSD-SOFT.
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07 1355 (07131) -  -  -  -  - Dimpled Plastic Dampproofing and
Waterproofing Membranes with Drainage:::::

This new proprietary section specifies Cosella-Dörken’s polyethyl-
ene sheet waterproofing, drainage, and vapor barrier sheets that
have a dimpled design that provides moisture drainage pathways
and an insulating air barrier.

Cosella-Dörken produces waterproofing membranes for use with
varying levels of environmental water, and drainage sheet to be
installed over waterproofing or dampproofing provided by others, or
without waterproofing or dampproofing.  Cosella-Dörken offers
options for vertically or horizontally installed drainage sheet, with
several levels of compressive strength; all are suitable for below
grade installations up to 30 feet deep.

Other specified applications in this section include vapor retarder
under slabs on grade, plaza deck and planter drainage sheets, bored
tunnel drainage sheets (panning liner), weather-resistive barrier in
above grade walls, and underflooring vapor barrier.

10 1400 - - - - - Signage (10400 -  -  -  -  - Identification Devices):::::

This section covers tactile signage —  ADA panel style with raised
letters and Braille made with injection mold, etched metal, engraved,
or applied character panels. It also covers silk screened and sand
blasted plastic non-tactile signage, and metal and plastic individual
letters.  Applications included are room and door signs. interior
directional and informational signs, building identification signs,
and emergency evacuation maps. Traffic signs and plaques could
also be added to this section.

01 3515 (01355) -  -  -  -  - LEED Certification Procedures:::::

This section was formerly titled “LEED Requirements.” The change
in title more accurately reflects the function of the section from the
Contractor's point of view. See the “LEED®-CS Added to SpecLink”
article on page 1 for further information.

06 1000 (06100) -  -  -  -  - Rough Carpentry:::::

Section 061054 / 06114 - Wood Blocking and Curbing has been
removed.  We were concerned about the duplicate provisions in this
section and in 061000 Rough Carpentry.  So we sent out an email
survey, asking how people used this section.  Based on the positive
response we got from users, the Wood Blocking and Curbing
section has been folded into Rough Carpentry.  A new, comprehen-
sive checklist has been added to Rough Carpentry that allows the
user to quickly "scope" the section -- from only minor miscellaneous
carpentry to a fully wood framed building. We believe the checklist
will be even more helpful than having a separate section.

The section has also been generally updated.  Note that we did hear
from some users about sometimes needing to have two "rough
carpentry" sections -- one from their structural engineer, just for
framing, and one for all the other carpentry that the structural
engineer isn't concerned with. In this case, we recommend that
Rough Carpentry be edited for the non-structural scope and then
copied to make a section of a different number and title from the
structural section.  This should be a simple enough procedure that it
can be done each time with a "fresh" updated copy of the Rough
Carpentry section.

Revised SpecLink SectionsRevised SpecLink SectionsRevised SpecLink SectionsRevised SpecLink SectionsRevised SpecLink SectionsNew SpecLink SectionsNew SpecLink SectionsNew SpecLink SectionsNew SpecLink SectionsNew SpecLink Sections

CSI CSI CSI CSI CSI THREE-PTHREE-PTHREE-PTHREE-PTHREE-PARARARARART SECTIONT SECTIONT SECTIONT SECTIONT SECTION
FORMAFORMAFORMAFORMAFORMAT SLAT SLAT SLAT SLAT SLATED TED TED TED TED TTTTTO CHANGEO CHANGEO CHANGEO CHANGEO CHANGE
As if a new CSI MasterFormat™ wasn't enough, CSI is now
preparing to change the Three-PART SectionFormat™!  The CSI
SectionFormat PageFormat Update Task Team (SPUTT for short)
has been meeting for almost two years with the goal of making the
Three-PART format even easier to understand and use.  BSD's
Susan McClendon has been on the team, bringing the perspective
of master guide specification providers to the wide array of points of
view gathered in the review process.  The proposed changes are
significant but not radical -- thankfully there are still 3 parts rather
than 4!  When the new edition of SectionFormat is published
(planned for June 2007), BSD will begin modification of the SpecLink
master database, implementing the changes by means of the normal
updating process, by which users may accept or reject any change.
Unfortunately, there will be no "switch" like for MasterFormat 2004 -
- instead, blocks of text will change locations within individual
sections.  We expect the process to take several quarters.  (By the
way, the PageFormat™ recommendations will also change, but with
no real consequence to SpecLink -- the existing built-in styles will
already be in conformance.)

to how to address each prerequisite or credit.  This section auto-
matically edits the list of relevant sections in the LEED Certification
Procedures section and can also be used as a planning tool.

01 3515 -- LEED CERTIFICATION PROCEDURES -- This section is
used in the Project Manual to explain the certification process and
the Contractor's role in it.  By editing this section you can activate
relevant LEED provisions in appropriate spec sections by making a
list of relevant sections for the Contractor's information.  (This
section was formerly titled "LEED Requirements" — the new title
more accurately reflects the function of the section from the
Contractor's point of view.)

The LEED CREDIT SUMMARY is used to document the project
team's intentions in regard to certification and particular credits.
First, either LEED-NC or LEED-CS is selected to edit the list of
prerequisites and credits.  Thereafter, for each credit, a status of
"Required," "Preferred," or "Not Required" may be set, as a record
of intentions.  Following the statement of each credit is a brief
description of predefined possible solutions, taken from the LEED
Rating System itself, each linked to the specification sections which
address the credit.  When one of the predefined solutions is

“LEED-CS” continued from page 1

See “LEED-CS” on next page
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Mode, Review Mode, and Subscription Mode.

The Evaluation mode is enabled by the lack of any license. The
Review mode allows the user read-only access to the documents for
which you have a license but does not increment the concurrent
user count. Subscription mode allows read-write access to all
catalogs for which the customer is licensed and increments the
concurrent user count by one for each user.

As we start to talk about user roles, we want to make it clear that the
implementation and use of user roles is not mandatory. In fact, SLE
defaults to a configuration that does not require user role assign-
ments. All users are essentially system administrators and have
access to all system functionality. However, once you check the box
to enable security, and assign the role of System Admin to one or
more users, no other user can access the system until and unless
they are specifically identified and assigned a role by a System
Admin.

There are six roles that can be set by the system or assigned by the
System Admin:

· Evaluation User (EVL)
· Reviewer User (REV)
· Standard User (USR)
· Expert User (EXP)
· Project Admin (PAD)
· System Admin (ADM)
Note that a System Admin does not have to be someone with
Windows administrator rights. In this article, Admin refers to a user
whose role in SLE is System Admin (ADM) and Windows adminis-
trator refers to someone with administrator rights on the Windows

network.

The Reviewer User has
read-only access through-
out the system and does
not have access to certain
commands. The Reviewer
User role does not add to
the concurrent user count.
The Evaluation User role is
forced by the Evaluation
Mode (essentially set by
the lack of any license).

This role cannot print or export documents, does not have access to
certain commands, and is limited by access rights to only a few
documents.

The Standard User (USR) role prepares documents for publication
and has access to all functionality not identified as specific to other
roles. The Expert User has the ability to add, modify, and delete the
following items while the Standard User cannot:

· Links
· Choice Fields
· Global Terms
· Document Templates
· Styles
There are two levels of role management: system level and project
level. The system level determines the user’s ability to access the
system and system level commands. It is also used as the default if
project level roles are not specified. When system level security is
enabled, it is possible to enable role management separately for each
project. That is, a System Admin can enable role management for a
given project and assign a Project Admin role to a user on a project
by project basis.

The figure on page 1 displays the Set Project Roles dialog for user
roles. The Project Admin has the ability to specify users and roles
that apply to that project independent of all others. Using project
level security, a user can be given Expert read-write access to one
project but not have any access to a second project. Another user
might be given a Reviewer role for a given project without any
ability to edit the project.

A user’s access for a given project can also be limited to certain
catalogs (groups of documents or specification sections) such as
the architectural catalog or the civil catalog. And a Project Admin
has the ability to create a project-level catalog (grouping of docu-
ments) and limit a user’s access to only the documents contained in
that catalog on this project.

SpecLink-E incorporates the experience we’ve gained over the past
decade and more, working with thousands of users. We welcome
your feedback as we move the product toward completion. Our
measuring stick will be your productivity and the quality of your
specifications, and we will not call SpecLink-E complete until we’re
completely confident we can measure up. We look forward to
completing this year, and to working with you to make your transi-
tion to SpecLink-E as seamless, as effortless, as possible.

LinkLine

A BSD SoftLink® Publication

Editor: Niki Koplowitz

The LinkLine is published by
Building Systems Design, Inc.
3520 Piedmont Road, NE
Suite 415
Atlanta, GA 30305

Permission to use excerpts in
other publications is granted
provided the publisher is notified
in advance at 404-365-8900.

BSD SpecLink, BSD CostLink and
BSD SoftLink are registered
trademarks, and BSD CadLink and
BSD LinkMan are all trademarks of
Building Systems Design, Inc.

Get the latest on BSD by visiting
our web page at
www.bsdsoftlink.com

“SpecLink-E” continued from page 1

selected, the appropriate specification section is highlighted in the Project Tree and the LEED-
related provisions in that section are activated by links.

For instance, if your project team has committed to using only "certified" wood, you can select
any or all of the Division 6 carpentry sections as solutions to MR Credit 7 (NC, Credit 6 in CS).
When you do, the requirement for certified wood (which SpecLink refers to as "sustainably
harvested wood") is activated in each selected section along with its LEED Report submittal
option.  In addition, the basic specification provisions and submittal requirements for sustainably

“LEED-CS” continued from previous page

See “LEED-CS” on page 7
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All ProductsAll ProductsAll ProductsAll ProductsAll Products

Is there a way I can get the software
to work on more than one computer?

If you currently have a standalone
installation, call Technical Support at

1-800-266-7732 to unpermit your current
installation.  Once the key has been unper-
mitted, you can perform a network installa-
tion and will be able to install the client on
multiple computers so that anyone can
access the program.  The number of concur-
rent users is determined by the licenses
purchased.

Where can I find the user’s manual?

The user’s manual is on the quarterly
CD.  It can also be found on our

website at www.bsdsoftlink.com. Select the
product at the top of the screen and then
select the User Resources tab. A hyperlink
for the user manual will be on the right-hand
portion of the screen.

I lost or cannot find my CD. How can
I install (or reinstall) my product?

Check with the point of contact in
your company to see if they received

the CD directly. If not, you may be on the
Download only list and the CD was not
shipped to you.  In that case, go to our
website at www.bsdsoftlink.com/
downloadcenter/userspage.htm. Download
the file to your local drive and then double
click on the file to start the installation. You
will need a serial number to complete the
installation — that number is slp4457117.
You should also download the Release
Notes for your application because they
include information you will probably need,
and they change every quarter.

SpecLink+ and PerSpectiveSpecLink+ and PerSpectiveSpecLink+ and PerSpectiveSpecLink+ and PerSpectiveSpecLink+ and PerSpective

I have a section that looks like a
subsection. How did that happen
and how do I fix it?

When copying an existing section or
creating a new section, you need to

be careful about which folder is highlighted
in the Project Tree. If you have highlighted a
section in the Tree, and you paste or create
a section, the new section will be a level
below the existing section.  If you need to
move the section, right click on the name of
the section in the Tree panel. Choose Cut
Section. The Cut Section for Pasting dialog
box opens asking for confirmation that the
correct section has been selected to cut.
Verify that it is and click OK. Right click on
the folder in the tree where the section
belongs and select Paste Section Into. The
Paste dialog box opens giving you the
opportunity to change the number, acronym
or name of the document. Verify the informa-
tion as correct and click OK. The section is
moved to the proper location. You can also
use this process to renumber a section.

I have some sections in Word format
that I am trying to add to my project.

What is the most efficient way to do that?

Add New Section from RTF File
allows you to create a new section

by importing an RTF file, without first
creating the section in SpecLink+.  (RTF
stands for Rich Text Format, which is
readable by multiple applications.  To make
an RTF file, open the Word document and in
Word choose Save As.  Change the Save As
Type dropdown to Rich Text Format (RTF).)
There are two settings on the Tools menu
that need to be set before you use Add New
Section from RTF.  If you have Auto-Select
New Paragraphs turned on, then all para-
graphs imported during the Add New
Section from RTF will be selected with a
checkmark.  There is a menu selection called
Look for Choice Fields in Import.  If this is
turned on (reflected by a checkmark in the
menu) the import will create choices within
the section based on coding used in the
RTF file.  Look in SpecLink Help under
Preparation of RTF file for Add New Section
from RTF File and Importing Choices for
more information.  If the Look for Choice
Fields in Import is not turned on, the
software will not create choices and
brackets will import as brackets, for example.

How do I create links between
paragraphs?

To make a link from one paragraph to
another:

1. In the Document Panel, position the
cursor on the paragraph that is to be the link
source. Open the Links Window by clicking
on the Links icon on the Toolbar, or choose
View > Links.
2. Click on the Target Links tab.
3. Scroll the Document panel to show the
paragraph that is to be the link target.
NOTE: Do NOT move the cursor off the link
source. Use the scroll bar and don’t click in
any other text cell.  The target can be
anywhere in the project, including a
different section.
4. When the target paragraph is visible,
using the mouse, position the cursor over
the status columns to the left of the text,
hold down the right mouse button, and start
to drag with the mouse. The cursor arrow
changes to a circle and bar symbol. Continu-
ing to hold the right mouse button down,
drag the cursor to any position within the
upper window in the Target Links tab of the
Links Window, and release the mouse
button. (Note: If you are not able to create a
link, be sure that you are dropping it into the
Target Links tab. You may also need to drag
more slowly when dragging the link.)
5. To change the type of link, double-click
on the green arrow under the Influence
column. It toggles to red. Another double-
click toggles it to yellow. The link is built
automatically and appears in the Target
Links listing. NOTE: User-added links
appear with underlining, to differentiate
them from master links. If the parent of the
target paragraph is active, the new link will
be activated immediately and will appear in
bold font in the Links Window.

CostLink/AECostLink/AECostLink/AECostLink/AECostLink/AE

When I try to open an older
CostLink/AE project I get an error

that says “Unable to locate the reference
database C:\CostLink AE\System\2004
Means AE Assemblies.MAS. The RS Means
Database will not be available.” How can I
resolve this error?

You have probably installed
CostLink/AE on a new computer and

no longer have the older RS Means data-
bases on your hard drive. They are available

Continued on next pagein zipped form on
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the quarterly CD. To open a project that was
created with an older RS Means database,
extract the database from the CD to your
C:\CostLink AE\System folder, using
WinZip. The databases are in a folder on the
CD called Misc. If you do not have the CD
available, email us at
support@bsdsoftlink.com and we will email
it to you.

CostLink/CMCostLink/CMCostLink/CMCostLink/CMCostLink/CM

Is it possible to print out just the
titles for my estimates with no costs?

We have a report that displays all
folders in any given hierarchy,

regardless of whether they contain cost
items and without displaying any existing
cost items.  To print it, open your project,
click on the File menu and choose Reports
Setup.  In the top left part of the Select
Reports tab, select the Report Hierarchy that

Continued from previous page

More questions?

Contact BSD Technical Support:

Toll Free: 800-266-7732
In Atlanta: 404-365-9226

Email: support@bsdsoftlink.com

you want to print.  Click on the Preferences
tab and then click on the box on the bottom
right that says Print Project Hierarchy
Structure Only.  Your report will be printed
to the screen.  To print it to the printer, click
on the printer icon on the top left corner of
the report print preview window.  To email
the report, click on the envelope icon on the
top left of the report window, choose the
Acrobat Format and click OK.  Click OK for
the Page Range and then navigate to the
appropriate folder for the exported file.
Name the file and then click on Save.  The
PDF file will be in the selected folder and
may be used as an email attachment.

Cost EstimaCost EstimaCost EstimaCost EstimaCost Estimating ting ting ting ting WWWWWorkshop Noorkshop Noorkshop Noorkshop Noorkshop Now w w w w AAAAAvvvvvailableailableailableailableailable
· Creating a new estimate with an RS

Means building cost model.
· Making modifications to the estimate to

accommodate costs not covered in the
building cost model.

· Creating a new estimate without using a
model.

· Adding cost items not found in the RS
Means databases.

· Copying tasks and folders from one
project to another.

· Moving folders within the project.
· Formatting and printing Summary and

Detail reports.
· Exporting reports to a PDF file and an

Excel spreadsheet.
· Backing up projects to a zip file.
· Overview of linking folder and task

quantities to folders and cells in an
Excel spreadsheet.

The initial workshops are being held in our
Atlanta office.  In addition to future work-
shops in Atlanta, we will also offer sessions
at other locations if demand is sufficient.
The workshop in Atlanta is priced at $595
and includes a workbook with multiple
exercises.  The workshop qualifies for 7 AIA
Continuing Education Learning Units.

After receiving many requests for a cost
estimating workshop, BSD has developed a
one-day training program that covers the
fundamentals of cost estimating for design
professionals using BSD CostLink®/AE.
This workshop orients users to BSD
CostLink/AE’s unique time-saving capabili-
ties and focuses on the effective use of the
RS Means parametric models. Using one of
these 75 models allows a design profes-
sional to assess an owner’s budget and to
prepare a detailed cost estimate at the very
earliest stages of a project. The designer can
then refine and modify the estimate as the
building design progresses, gradually
replacing model-generated assemblies and
quantities with those that have actually
been selected for the project. By following
these procedures, designers are able to print
an updated cost estimate at any stage of the
project and can avoid surprises on bid day.

Subjects covered in the workshop include:

· Overview of the software and the RS
Means cost databases.

· Navigation within projects and the
databases.

· Using the Find feature to find
assemblies and tasks in the RS Means
databases.

harvested wood are activated in Section
01600 Product Requirements, as well as
the form for documenting wood content,
the LEED WOOD-CONTAINING PROD-
UCT LIST.  Similar provisions are acti-
vated for each predefined solution that
involves the specifications.

For further coordination, the specification
sections that have been activated are also
listed in Section 01 3515 (01355) - LEED
CERTIFICATION PROCEDURES.  The
intention of this section is to inform the
Contractor about LEED Certification,
explain what his responsibilities are, and
draw his attention to specific sections of
the Project Manual that address LEED
credits.  The LEED-related specification
sections are listed in MasterFormat 2004
section number order — as opposed to
LEED credit order in the LEED CREDIT
SUMMARY section.  When the Credit
Summary section is prepared first, it will
activate all the relevant sections in the
LEED Certification Procedures section.

Although the Credit Summary is explicitly
intended for making a summary document
early in the project, the LEED Certification
Procedures section can also be used to
"build" the Summary document, by means
of links from the section number ordered
list back to the credit number ordered list.
This will be especially useful where the
same specification section addresses
issues that arise under different credits —
all the credits relevant to a particular
section are grouped under the section
listing.  Reviewing the list of relevant
sections in both section number order and
credit order will give the most complete
picture.

These SpecLink specification sections are
based on the LEED-NC Version 2.2 and
LEED-CS Version 2.0, by the U.S. Green
Building Council.  Intelligent use of these
sections requires familiarity with the
applicable Rating System document which
can be obtained free of charge at
www.usgbc.org.  The applicable LEED
Reference Guide would also be of consid-
erable assistance to designers and
specifiers.

“LEED-CS” continued from page 5
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BSD SpecLink+
Either Day*  $495
Both Days*  $895

March 13 - 14, Atlanta
March 20-21, Chicago
Apr 12-13, New York
Apr 17-18, Atlanta

May 22-23, Tampa, FL
June 12-13, Atlanta

June 28-29, San Francisco

AIA Members: We will report your course
completion for 7 or 14 Continuing Education

Units
CSI Members: Submit Course Completion

Certificate for 7 or 14 Education Contact
Hours (ECHs) toward your CCS, CCCA, or

CCPR Certification renewal

* Class starts at 9:00 AM and ends at 5 PM.

BSD CostLink/AE
1 day*  $595

BSD CostLink/CM
3 days*  $1295

Scheduled on a demand basis.
Call 888-273-7638.

AIA Members: Submit Course Completion
Certificate for 7 Continuing Education Units
for CostLink/AE training, or 24 Continuing
Education Units for CostLink/CM training
CSI Members: Submit Course Completion

Certificate for Education Contact Hours
(ECHs) toward your CCS, CCCA, or CCPR

Certification renewal - 7 for CostLink/AE
training, 24  for CostLink/CM training

* Class starts at 9:00 AM and ends at 5 PM.

The BSD SpecLink+
Workshop

The BSD SpecLink+ Workshop consists of
two one-day workshops.  The first day is
devoted to learning the basics of
SpecLink+, including how to navigate
within the software, start a new project, edit
sections, understand how the links and
choices work, and how to format, print and
export the final document.  It is designed
for new users.  The second day is designed
for those who want to learn how to create
and maintain their own office master.  This
day covers the concepts of an office mas-
ter, how to customize your master by add-
ing choices, links, and tags, as well as cre-
ating your own checklists.  Users must al-
ready be familiar with the basics of
SpecLink+ to attend the second day.

View BSD class schedules on our website! Go to www.bsdsoftlink.com and click the Training link. Get directions & information on travel, hotels, & Atlanta!




